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1.  INTRODUCTION 

Any documentation always begins with a little introduction text, in which we'll talk about some basic 
principles of the software: available editions, activation and some notices about the way to read this 
guide. 

Please take a moment to read this introduction. You'll understand the role and the way the software 
runs so you'll be able to use it as efficiently as possible. 

What is eMedia CS2? 
The software is an integrated application that allows you to design and print plastic cards on any card 
printer. 

Of course, you may use any existing and installed program on your computer to do, but eMedia CS2 
also allows you to: 

• Encode the magnetic strips, the Smart Card and the Contactless Smart Card, 

• Help people with low skill level in computing to print out cards in just a few seconds, 

• To print out data contained in your own databases, 

• To print out calculated data, 

• To store information that relates to the cards printouts and the program usage in a database or 
in a log file, 

• To print in a single pass on cards: texts, images, barcodes, the holder's picture acquired from 
any Twain / WIA camera or webcam. 

For these purposes, eMedia CS2 was developed to be used in three distinct modes: 

 

The design mode allows the creation of the template. It contains all the information 
that relates to the contents of the card and the way to use it to print the plastic cards 
out. 

This mode is used by the card creator, the application developer or the solution 
integrator, from the elements defined by the graphic team and from the available data. 

 

The operating mode allows the user to enter the data that must be printed on the 
card or entered in the database linked to the card, and/or to be encoded. The 
information, defined in the card template, will be entered from a specific input window 
dedicated to this usage. 

This mode will be used by the people in charge of printing the plastic cards out, from 
the templates defined by the designer. The utilization of this mode doesn't require any 
computer skill. The person in charge of entering the data has only to enter the 
information and to print the card out. 

 

The COM Server mode (Component Object Model) allows you to add to a third-party 
program the ability to print and encode plastic cards, using eMedia as an expansion 
module. 

This mode will be used by the application developer or the solutions integrator. It 
allows the printout and the encoding of plastic cards from a template defined in design 
mode and from code in his/her own program. 
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Different Editions of eMedia CS2 
eMedia CS2 exists in four editions for different kinds of utilization and features needed. Three of these four 
editions require the user license to be activated, and this aspect of the software will be described below. 

While installing the software on your computer, 
this one contains all the features of the Expert 
edition, but only the Trial edition features are 
enabled. 

You may activate an edition at any time, just by 
entering in the software your license key. This key 
must only be entered once; its purpose is to 
unlock the corresponding features. 

In addition to these four editions, eMedia CS2 also 
contains a specific functionality, called 
"demonstration mode", in which all the software 
features can be checked out. You may then define 
by yourself the edition that best fits your needs 
and decide to buy the corresponding license: 
Professional or Expert. 

The "Trial" edition works like a "Standard" edition 
for 14 days after the program installation. After this initial period, this edition is not able to print out production 
cards anymore, but only demonstration cards. 

In demonstration mode, the software cannot also print any production card, and only prints out 
demonstration cards. These ones look like the production cards, but they contain the label "DEMONSTRATION" 
on them, so they can't be used for a normal usage. In this mode, the encodings are not also performed 
(magnetic strips, smart card and contactless smart card). 

 

The differences between the four editions of eMedia CS2 are 
displayed in this table. 

A column, reserved to the demonstration mode, displays the 
features this mode allows. 
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Design and printouts of plastic cards  ü ü ü ü ü 
Printouts of demonstration cards (see below)  ü    ü 
Magnetic strip encoding  ü ü ü ü  
Smart card encoding (external program)    ü ü  
Contactless smart card encoding (external program)    ü ü  
Contactless smart card encoding (internal process)     ü  
Database utilization (MS-Excel worksheets)   ü ü ü ü 
Database utilization (all standard database types)    ü ü ü 
Using formulas in text and barcode objects    ü ü ü 
Using plug-ins    ü ü ü 
Using COM Server features    ü ü ü 
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Registration/Activation of your eMedia CS2 license 
When you install eMedia CS2 on a workstation, all the features of the program are installed, but some are 
inactive. To be activated, these features require a license.  

The setup can be downloaded here: https://www.eMedia CS.com/page/download  

When the program is started up for the first time, you are prompted to register your license key.  

You can start the activation process only if you possess a key. 

If you do not have a license key, your copy of the software is limited to 14 days. This "Trial" version will function 
during 14 days like a "STANDARD" edition. 

 

 

How to obtain a license? 
 
We (Mediasoft Development) don’t sell in direct so you’ll have to contact your usual reseller for that. If you 
don’t have one, you can contact us that we redirect you.  
As usual our contact email is support@emedia-cs.com  

How to register your software copy? 

Online Registration  

If you indeed have a License Key, open the "Help" menu and select the "Register your software copy…" 
option, and follow the steps in the next pages displayed on screen. 

 

 

Check “ Activate now ! “ 

 

Enter your license key here 

 

  

Follow the next steps, the other informations are optional, but they can be useful in the case of a license 
recovery in the future by our services. 

At the end if the PC on which you want to have eMedia CS2 activated is connected to the Internet and 
the connection is active, by clicking on "Next", you authorize eMedia CS2 to connect itself to the 
activation server. If your License key is valid, your copy of the software will be activated. A confirmation 
message will appear. 

"Thank you. Your software copy is now activated, and you have access to the features of the XXX 
Edition of the software" 

 

Please check out your anti-spam software to avoid quarantining or 
reject any message that could have been sent by our License Server. 
 

mailto:support@emedia-cs.com
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Offline / Manual registration 

If the workstation on which eMedia CS2 is installed does not have Internet access, or if the http port 80 
is restricted behind a proxy or any other case, you must save the registration link on your hard disk or 
any other support (USB key, for example). An Internet shortcut will be then be created and a 
confirmation message will appear. 

 

 

 

 
 
 
 
 
 
You will receive an e-mail from the activation server at the e-mail address that you indicated. It will invite 
you to select and copy three lines of information displayed between dotted lines. 
 

 

 

1. Select only the three lines between the dotted lines, 
2. Copy these three lines into a text editor (Notebook, for example) and save this file on a USB 

key. 
3. Insert the USB key into the PC containing the eMedia CS2 installation to activate and open the 

file using Notepad; then copy the three lines of text. 
4. In eMedia CS2, open the "Help" menu and select "Activate your license", paste the three lines 

of text and press "OK". 
5. It’s finished! Your software copy is now activated, and the corresponding features are 

immediately available. 

 

A video for the offline activation is available on our channel: https://youtu.be/0fkVDeEhRP8  

 

"The activation file has been saved. You can copy it on another 
computer, then double-click on the file to perform the activation." 

 

https://youtu.be/0fkVDeEhRP8
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2.  DESIGNING A CARD TEMPLATE 

Let's start the software and review the first basic knowledge. In this chapter, we'll introduce the design 
mode and the operating mode, and we will print out our first cards. 

Launching eMedia CS2 
To start the application, we may either use the icon created on the desktop by the installation program, 
or use in the "Start" menu, "All programs", the "eMedia CS2" program group, where the shortcut is 
located: 

• eMedia CS2 “launch the program in operating mode for printing cards out.” 

Upon loading, a splash screen appears, followed by the “Open template” window. 

 

You can see here directly the last used templates with some usefull 
informations: 

- Timed opened 
- Last used date 
- Template path 
- Connected or not to a Database 
- Double side or not. 

 

By default, after the setup you’ll see some of our sample, but it will be 
replaced as soon as you create and use yours. 

 

For now, just discard this window by hitting the close button in the upper 
right corner. 

 

Now eMedia will be in the main Operating window mode as in the screenshot below:  

 

The "Operating" mode is the user mode in 
which the badges are printed. In this 
mode, the card file is displayed with all the 
objects created in Design mode.   

Switch to "Design" mode by clicking the 
“Design mode” icon as we want to create 
a new card! 
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The Elements Displayed in Design Mode 
 

The main window of the application contains common elements we can find in any Windows 
application: a menu bar and a toolbar at the top of the window. A status bar at the bottom of the window 
gives useful information concerning the localization and the keyboard state. The window also contains 
four specific elements: the current card template, the toolbox, the layers layout window and the 
properties pane. 

The current card template view 

The visual is in the central part and should be empty at this time. We'll add to this template a 
background picture and the objects to print out. The bar at the top of the template shows the card side 
and the current zoom level. 

 

To design a double-sided card, or a non-standard sized card, or a portrait 
card instead of a landscape card, let's open the "Card" menu.  

 

You will be able to select the size, the number of sides and the orientation 
of our template, you can switch between both side with a tab system 
afterwards. 

 

 

The zoom level for the active side can be changed from the "View" menu or by pressing the F8 key on 
the keyboard. A grid helps to adjust the position of the objects. The “align to grid” comportment of the 
mouse may be defined from the card properties and from "View -> Grid" menu. 

Cards options are not definitive, you'll be able 
to change them at any time. 
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The toolbox (upper left side) 

On the left of the window, a vertical panel contains all the objects. We may add 
to the card layout during the design of the card template: text objects, images, 
photos, barcodes, clipart, lines, rectangles, ovals, magnetic strip programming, 
smart card programming, contactless smart card programming and ClipArt 
object. 

When we move the mouse over one of these icons, a tooltip appears, showing 
us the kind of the corresponding object. 

The layers panel (lower left side) 

 

In eMedia CS2 the layers are like sheets of glass 
on which each object rests. We can see through 
transparent areas of a layer the layers below. We 
can move a layer, above or below, like sliding a 

glass in a stack. We can equally modify the opacity level of a layer to make 
its contents progressively more transparent. 

The Layers panel lists all the layers on the card. We can display, mask or 
move the layers vertically up or down. We can access other commands and 
options via the properties of each object. 

 
 

The properties panel (right side) 

On the right, the properties panel shows all the properties 
(i.e. characteristics) of the currently selected object, and, if none is 
selected, the properties of the current card side. 

These properties are specific to each kind of object, so, the contents 
change each time we click on an object. To select an object, we just 
click on it. To deselect any object, we just need to click on the window 
background, in a place where there is no object. 

The properties pane looks like this one and contains: 

• At the top, the object name selected is displayed,                                               
here "Card side properties", 

• The list of the properties with their respective values, 

• A succinct help for the selected property in the down of pane. 

 

To modify the value of a property, we just click on the button on the 
right of the property to select in a combo-box the needed value or to 
make a dialog box to appear. We may also use the keyboard to enter 
the new value, whenever it's possible to. 

 

This guide is not intended to explain all the properties of all the object kinds, so we'll only explain some of the 
most used properties. 
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The Background of a Card 
 

Now a little practice, from your blank card template, we’ll insert the background picture. 

Click on the card (where there's no object) to make the properties pane shows the characteristics of the card. 

 

Click on the "Picture Store" property.  

 

 

Select "Picture stored on disk or on the internet” and click on the “Picture” property that just appeared. Chose 
“Select an image on disk”. Browse your local or remote hard disks with the common "Open" dialog box and click 
on the "Open" button once the image found. The filename of the picture then appears in the property, and 
the card background now contains the picture. 

 

Please notice that eMedia CS2 considers that the 
background picture is an image that must cover all the 
card background. To obtain the best possible printing 
quality at common 300 dpi on a CR80 card, printer 
manufacturers recommend a size multiple of 1016 
pixels wide per 648 pixels height at least. 

 

For the “Select an image on the internet” option, eMedia will need the full link starting with http:// and ending 
with the file extension, *.jpg for example. The workstation will have to be online at each time you’ll open the 
template since the picture will be dynamically loaded. 

The Identity Picture of the Card Holder 
Now, let's add the identity picture of the card holder. We may use one objects from the toolbox for this 
purpose: 

A picture can be a fixed object, such as a logo or an illustration, used as background 
for the design of the card, or a picture considered as a variable (ID Picture in this 
example). As a variable, in operating mode, the user will be able to change it by 
selecting a picture file on disk or by acquiring the photo from a digital camera or a 
webcam. 

 By default, in design mode, the program displays a generic image with a white background. After clicking the 
icon, the corresponding object is then created in the card layout and is also already selected: height handles 
around it help us to move and resize the object in any direction.  

The background of the card template is 
now defined 
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Now, tp move the picture object, place the mouse pointer over 
it, click and drag to the correct place.  

To resize the object, same thing, click and drag any of the 
handles around the object. Drag the handle to the new location, 
and drop the handle to review the result.  

 
Note that you can also move your object around the card while its selected with the keyboard’s arrows. 
 
 
The properties panel on the right is now currently displaying the picture object properties. We'll notice the following in 
the properties list: 
 

The "Object Name" property permits to give a name to the object. This will be useful 
later to find an object on the card, the name cannot contain any space, so please use 
an underscore “_” instead. 
 
For the “Image Type” 
- "Fixed Image" is a set object created in the creation mode, without a value having to 
be entered in operating mode. A "still image" displayed on the card will be same for 
each of the individuals. This object often forms the background design of the card. 
(logos - illustrations)  
- "Picture" is a variable picture that requires a value to be entered in operating mode 
by the user or via a connection to a database. 
 
“Picture”: Displays the name and disk path of the current picture and allows another 
source of the object to be selected.                                                     
-"Select a picture on disk", just browse to the targeted picture to select it and it will 
display the selected picture in the active card.  

-"Select an image on the internet" You’ll be prompted a complete URL.  
-"Acquire a picture" by launching the Acquire command, we activate the connection to the selected device's driver. The 
picture acquisition requires connection to a device such as digital camera, scanner, webcam to standard Twain or WIA 
(Windows Image Acquisition) for Windows, or by the "Folder SUPERVISON ".  
-"Select a Source..." Every acquisition peripheral of pictures contains a different driver. When we use an acquisition 
peripheral that use a normalised driver, Twain or WIA (Windows Image Acquisition), select the source suited before 
clicking Acquire. 
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The “Picture store” options allow: 

- "External file on disk”: The disk path (URL. Uniform Resource Locator) of this 
file will be copied into the card model. That implies that it cannot be moved 
from its original directory or it will no longer be displayed on the card. 

- "Template file": eMediaCS2 will store the picture in binary in the template file 
(*.eccs) 

- "DB field as a path to a file": Before establishing the connection, verify that a 
specific field for recording photos exists (text type field) in the database. This field will be necessary to add 
the photo file access path each time we register an individual. 

- "DB field as a binary object": eMediaCS2 can store the photos as binary data (BLOB: Binary Large Object) 
in a field in a database such as Microsoft SQL Server or Oracle. 

Some database types can store pictures as binary objects. Other just can't. So, to be coherent, the software 
only stores in the database the file name and path of the picture stored on disk and “Db field as a path to a 
file” will be the more commonly selected. 

 
 
“Position”: Allows to control the size and position of the object on the card in its properties window. 
 

  •Distance of left position from left border, 
 •Upper position from the top, 
 •Width extended to the right,  
 •Height of the object. 

 
We may change the zoom level, and the automatic zoom feature (on 
by default) that adapts the zoom level to try to display and print the 
most part of the picture. 
Beware on the fact that if we change the AutoZoom and Zoom 
properties, all the holder’s pictures will have to be similar in 
dimension and layout to guarantee a perfect result. 

 
“Cropping”: The crop properties that will allow to extract from the whole picture only the interesting part. 
To be able to crop you’ll have to deactivate the “Automatic zoom”. 
 
“Rotation”: By inputting an angle, we can rotate a text or a picture by an angle of 0 to 360 degrees.  
 
“Opacity”: We can vary the opacity of a layer between the default value 100 % (total opacity) and 0 % 
(transparency). When a layer is partially transparent, we can see the layers below.  
 
 

Transparent areas in pictures can be colored, if you use the PNG file 
format. 
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Giving some help to the user 

When this card template will be finished, maybe the person in charge of printing out the cards will not 
have the skills we'll have after reading this guide. So, we must give him information so he'll be able to 
enter the data correctly. For this purpose, two properties have been included in the properties pane: 

 Text is a short text, just a label, which will be displayed in 
operating mode in front of the text-box the user will have 
to fill in, so the user will be able to understand what he's 
expected to enter there. 

Order: This command affects the vertical positioning of the 
input window fields in the operating mode. 

ToolTip is a help text which will be displayed below the text-
box and in the status bar when the user will move this 
cursor on the lane. He'll have some information about the 
data to be entered there. 

 

 Visible: 

This parameter, which applies to any object, allows us to 
manage how it is displayed in Operating mode. 

• True it will be displayed in Operating mode. 
• False it will be invisible in Operating mode. 

Hidden: 

This parameter is primarily meant for writing, in design mode, repeated formulas or expressions that 
enable we to ultimately display a final value. In which case, it can be useful to mask them and only 
display the result. 

(Warning) We must equally add the parameter "Not Visible", if we do not want them to be displayed in operating 
mode. 

Locked: 

If it is locked, the object can no longer be accidentally moved or resized. The parameters of the 
properties window remain active. 

 

The holder's name and other text objects 
 

Let's add some new information on our card template: the holder's name. For this purpose, we'll add a 
text object then define its properties so he'll be able to contain the information.  

In the toolbox on the left, click on the text object. This one appears on the top left of the 
current template. Notice that for two-sided cards, the object appears on the current selected 
side. To ensure that the creation is made on the correct side, we need to click on the target 
side before clicking on the icon in the toolbox. 
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The display now looks like:  

 
Once our text object has been created 

The "Properties panel" dialog box helps us to specify, at the creation time, the three main 
properties of a text object: 

 
Object name: Internal name of the object followed by 
its order number. To properly identify the objects that we 
lay out on the card, it is preferable to rename them 
according to the data that they must contain as example: 
“Last_name” “First_name” “Address”   
“Reference_number”  etc. 
 
The object name must be an identifier 

1. It must start with a letter 
2. The name can only contain letters, digits and the underscore character. (_). All others 

thing are unacceptable 

Source defines the kind of information that this object will contain, 

Data defines the information itself. 

The dialog box appears each time an object is created and when double-clicking on the object. 
 

The sources of the data 
Let's open the "Source of the data" combo-box and see what's in 
there: 

• Fixed tells the software that the text in the object will not 
change in operating mode. The user will not be able to modify 
it. The "Data" property contains the information to display. 

• User input tells the software that the text will be entered by 
the user in operating mode, from a text-box in an input window. 
The "Data" property contains the default value to be used if the 
user doesn't define the contents of the object before printing 
out. 
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• Print counter tells the software that the object will contain a numeric value. This value 
will be changed automatically each time the card is printed out. This will allow, for 
instance, a numeration of the cards. We may define the first value and the added value 
for each printout in the dialog box displayed from the "Print counter" command of the 
"Tools" menu. The "Data" property is unused. 

• Date and time tells the software that the object will automatically contain the current 
time and/or the current date of the printout. The "Data" property is unused. 

• Formula tells the software that the object contains a formula. This formula is calculated 
each time a data is entered by the user in operating mode, or when the printout occurs. 
The result of the calculation is then shown in the object. The "Data" property must 
contain the formula. 

• Database field tells the software that the object will contain the value of a field of the 
current record of the database linked to the card template. The "Data" property must 
contain the name of the database field. 

• Choice list tells the software that the object contains a list of possible values. In 
operating mode, the user will select in a combo-box one of these choices. We will enter 
the different possible choices from the "Data" property. 

• Database choice is a little bit more complex, as it is the combination of the "Database 
field" and "Choice list" sources. This kind of source tells the software that the user in 
operating mode will be able to select a value from possible choices. These choices will be 
extracted from a second table of the database. Once a value is chosen, this value, or a 
foreign key, will be stored automatically in a 
field of the main table. 

• Script is a set of instructions. 

 

 

Please notice that it's not possible to use all the 
possible sources with a Standard Edition of the 
software. Some sources only work with a Professional 
or Expert Edition. 

We may also check out these sources, expression, 
database field and database choice by enabling the 
demonstration mode from the "Help" menu. Don’t 
forget that enabling this mode prevents the user from 
printing out usable cards. 

 

 

 

We'll be pleased to have the name of the card holder in this text object. As this information will 
be specific to each printed card, we can't use a fixed source, and must use a variable one. So, 
choose the "User input" source, so the user in operating mode will enter the holder's name 
before printing out. 
Insert in the "Object name" dialog box the value Name 
Insert in the "Data" property a default value. The dialog box will then look like: 
 

 
 

Professional or Expert Editions 
Demonstration mode 

Trial & Standard Editions  

Fixed ü ü 
User input ü ü 
Print Counter  ü ü 
Date and time ü ü 
Expression  ü 
Database field  ü 
Choice list ü ü 
Database choice  ü 
Script  ü 
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Entering the properties of our text object 
 

Now move the text object on the card so it reaches its printing position. Give it a width and a 
height compatible with the expected contents and the background illustration. 
Now, let's review the available properties: 

• The "Font" property will help us to change the style and the size of the font. 
• No resizing: We must manually resize the text 

area, using the handles, to be able to fit the entire 
chain of characters in object. 

• Automatic resizing to fit: eMedia will 
automatically adapts the size of the font in relation 
to the length of the text contained in the object. However the longer the text will be, 
the smaller the font will be adapted. 

• The "Word wrap enabled" property allows us to write the text on more than one line. 
 

Presenting the information 

The "Format" property may be used to 
define an automatic layout mask for our 
text. It's very useful for numeric values or 
dates. The user in operating mode will 
then be able to enter the information as he 
wants and eMedia will, by itself, change 
the presentation of the data to fit your own 
specifications. 

To specify a format, click on the button on 
the right of the "Format" property, and 
click on the "Choose format" choice. In the 
dialog box that appears then, select the 
data category, then the needed format. In 
the example on the right, as we want to 
force the upper case, we selected the "Upper case" format. 

If we use the Microsoft Office™ Suite, we'll find all these formats very familiar… The format 
strings in eMedia CS2 are the same than those in Microsoft Excel™. 

The example text-boxes at the bottom of the dialog box help us to review how the data will be 
presented using this format: enter a value in the "Value" text box, and see the result in the 
"Formatted" text-box. 

 

And now the Aspect: 

 

By default, a text is black. To have colored text, we must 
to choose a color and an opacity level. 

Horizontal alignment 
Left... Aligns the text to the left in the delimited area 
Center...Centre the text in the delimited area 
Right... Aligns the text to the right in the delimited area 
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Vertical alignment 
• Top... Aligns the text at top of delimited area 
• Middle... Aligns the text in the middle of delimited area 
• Bottom... Aligns the text at the bottom of delimited areaRotation 

 

Rotation 

By inputting a value, we can rotate the text by an angle of 0 to 360 degrees.  

 

By default, a text object is transparent. To have a 
colored text, we must to choose a color and an 
opacity level. 

 

 
• Type: Selection of a border style, 
• Width: Thickness of the frame border, 
• Color: Access the Windows color palette, 
• Opacity: Level of opacity of the color. 

 

Giving some help to the user 
When this card template will be finished, maybe the person in charge of printing out the cards 
will not have the skills we'll have after reading this guide. So, we must give him information so 
he'll be able to enter the data correctly. For this purpose, two properties have been included in 
the properties pane: 

• Text: is a short text, just a label, which will be 
displayed in operating mode in front of the text-box 
the user will have to fill in, so the user will be able 
to understand what he's expected to enter there. 

• ToolTip: is a help text which will be displayed 
below the text-box and in the status bar when the user will give focus to the text-box. 
He'll have some information about the data to be entered there. 

• Order: This command affects the vertical positioning of the input window fields in the 
operating mode. 

We'll define these properties as shown on the right, so the resulting input box for the user in 
operating mode will look like the one displayed below: 

 

 

 

 

 

 

Exercise 

Try now to add to your card a text, rotated 90°, containing 
the print date. The screen shot at the rigt shows the 
expected result. And, if you think you're not able to do this, 
read the following… 
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There are many ways to perform this job. We'll not 
describe the easiest one, but we'll show we the most 
powerful solution.  

 

The first thing to do is to create a text object 

 

As we want to display the print date, we'll define the 
source property to "Date and time". 

 
To print out the date as needed, we'll apply a format 
containing the correct date format: "mm/dd/yyyy" 

 

 

 

 

 

 

 

 

 

The text must be blue and, to be well visible, a background soft opacity white. 

 

The text must be printed vertically, so we change the 
"Rotation" property and set it to 90. 

 

Now, we move the object near the right border of the 
card, using the all available width, so that the grey of 
background covers the entire area. 

 

      It should look like this. 

 

The text and ToolTip properties have no 
interest. This is because the source of this 
text object is "Date and time". As the 
contents of the object will be defined 
automatically by the computer, and will not 
be entered by the user in operating mode, 
there's no need to specify any help text. 
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If you’re perfectionist and requires an exact position of the object 
on the card, you can enter it yoursef, manually from the keyboard 
with the four coordinates of the object, using the "Top", "Left", 
"Width" and "Height" properties. The values of these properties are 
always in millimeters. 

 

Let's go a little further 
With a Professional Edition or an Expert Edition of eMedia CS2 (or by enabling the 
demonstration mode), we may use more powerful features: formulas. 

We may tell eMedia-Cards CS that a calculation is to be performed. We'll enter in your card 
design the formula to be computed and eMedia will calculate the result. 

Suppose, for instance, that your card must contain its own expiration date. This one will be 
calculated from the start date (entered by the user in operating mode). The card will expire 90 
days after this start date. 

The screen shot on the right shows the properties of 
the text object which will contain the start date. 

Set the properties as: 

• Name is set to "tStart" as we'll need to use this 
name in our formula. 

• Source is "User input" as the operator will 
have to enter the start date, 

• Default data contains "15/09/2017" as a 
default value, 

 

• Text and ToolTip are set to useful help texts, 

 

 

 

 

 

 

 

Now let’s place this objects outside the cards. It 
won’t be printed nor displayed, and won’t stay on 
the card to avoid missclick. 
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Now, create a new text object for the expiration 
date. Set the "Source" property to "Formula": in 
operating mode, the user will not have to care about 
the expiration date; this one will be calculated 
automatically by eMedia CS2 from the start date 
entered. 

 

 

Click on the "…" button on the right of the "Data" 
property of this new text object to display the 
formula wizard: 

 

As the original date is entered by the user in 
operating mode and stored in the "tStart" object of 
the card, select "In the value of a card object" and 
click on "OK". The wizard displays the list of the 
objects. Select "tStart" and click "Ok". 

 

 

 

 

 

 

 

 

 

 

 

 

The wizard asks us for the number of days. As defined above, select "I'll enter the information 
now", click "OK" and then enter the value: 90 and click "OK". 

The complete formula is now displayed as: 

Format(DateValue(@tStart) + "90", "Short Date") If this formula is correct, just click "OK". 

 
 
 
 
 
 
 

Evaluation of the formula 
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The user interface is the following: 

Our formula is displayed in the bottom area and we may modify it to add an object of the card 
or a function of the software by double-clicking in the two hierarchical lists above. 

As the formula corresponds to our specifications, we may click on the "Check" button at the 
top. A message tells us that the formula is correct and will return the value. 

For more information about the formulas, click on the "?" button  

 

 

A specific help will appear, containing all the needed information to build powerful formulas and 
the full reference about the built-in functions. 

 

As you can see in operating mode the displayed date will always be calculated 90 days after 
the Start Date entered by the one who prints. 
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A barcode with the membership number 
We may create and manage the barcode objects exactly as we did with the Text objects. In 
this paragraph, we'll create such an object, which will contain the member 
number to our rugby club. 

Click on the barcode icon in the toolbox on the left (see the icon here): 

The "Properties definition" dialog box appears, so we'll be able to select the 
source of the data and the contents of our barcode. It's the same dialog box than the one seen 
before. 

If our barcode must contain the member number, this number must change for each new 
printout automatically. Thistime we'll use a print counter. Select "Print counter" in the "Source" 
combo-box.  

 

Be sure to have at blank background of at least 
80%, as it must be clean to allow LED barcode 
readers to read it.  

These readers are only able to read barcodes in true 
black (K ribbon) over a background that has a 
constant luminosity level. We may choose any other 
color than the white for the background, but you’ll 
have to keep the contrast.  

 

 

 

Let's review now the main properties of the barcode object we created. We'll not describe again 
the properties seen for the text objects, but only the new ones and those which don't have the 
same purpose: 

• The "Font" property is to be used to select the barcode type to use. 

• The "Show the Barcode Value" property defines that the value of the barcode must be 
written below the bars. If this property is set to "True", then the "ValueFont" property 
defines the characteristics of the font used to write this value. 

Characteristics of the print counter 
When a print counter is defined in a card template, 
its default value is set to one, and 1 is added to this 
value each time a printout is performed. To change 
the default value and/or the value added at each 
printout, we may configure the counter, from the 
"Print counter" command of the "Tools" menu. 

The following dialog box appears: 

The "Value" text-box contains the value to be printed 
on the first card. Here, we consider that the first member will have the value 123. 

The "Increment" text-box contains the value that will be added to the counter once the printout 
performed. 

The "Digits" text-box defines that the counter must contain x digits. The counter value will be 
truncated if needed. 

There's a preview at the bottom of the dialog box to review how the counter will look like on 
the first printed card.  
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In operating mode, the card will look like this 

 

 

The magnetic strip 
If we need to encode information on the magnetic strip, a wizard has been designed to help us 
creating the corresponding formula, as the magnetic strip is considered by eMedia CS2 as an 
object, having its "Source" property set to "Formula". So, we have to 
enter in it as a formula.  

To specify the contents of the magnetic strip, just click on the 
"Encoding" tab in the toolbar. 

Once the tab opened, click on the "Magnetic strip" icon (see the 
corresponding icon on the right). 

The magnetic strip encoding dialog box appears: 

 
"Magnetic strip encoding" dialog box 

The radio buttons at the top allow us to select the type of encoding to perform: 

• ISO: the encoding will be compliant to the ISO standards. eMedia CS2 will check out the 
data to encode to comply the norm. 

• Non-ISO: the encoding will not be compliant to the ISO standards, eMedia CS2 will not 
check out the data to encode. 

• JIS Type II: the encoding will be compliant with the Japanese standard. 

The three text-boxes allow us to enter the three formulas (one for each track) or the only 
formula for the single track on the front side of the card if "JIS Type II" was selected. 

Each text-box must contain a formula, and this formula must return a string, having the max 
length specified under the text-box. The return value must also contain either only digits 
(numeric only tracks) or digits, characters and some symbols (alphanumeric tracks). 

During the encoding phase, any data that will not correspond to the ISO standards (for ISO 
encoding), will be replaced by eMedia CS2 by space characters, or will be removed on numeric 
tracks. 

Two buttons on the right of each text-box, display dialog boxes helping us to define the contents 
of the track: 

 
Magnetic strip tool 
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 This button opens the "Formula wizard" dialog box seen previously. This dialog box will 
help us to create and test the formula. 

 This button opens a wizard that will allow us to build the contents of the track on a 
step-by-step basis. At each step, we'll be asked if we want to add or concatenate 
objects of the card, fields of the database, fixed data, etc. 

Let's use this button now to call the magnetic strip wizard. We'll define in it, one at a time, the 
elements that will be concatenated on the track. We'll be able to review the formula later, using 
the Expression wizard (first button on the right of the track contents) for instance to enhance 
it with new calculations. 

Click on the button on which is a magic hat and follows step by step the configuration of the 
track. 

Click on "Next" and begin the configuration of the track. We'll suppose, for this 
demonstration, that our track will have to contain the holder's name, the start and end dates 
of membership, all these data separated with the normalized separator character for ISO 
track 1: "^". 

 
 

The dialog box displays the first step, in 
which we must choose where, is located the 
data used for encoding: in an object of the 
card, in the database (if a database is linked 
to the template), to be asked to the user, or 
a fixed data.  

 
 

Select "A data that is on the card" and click 
"Next". As the holder's name is in the text 
object named "tName", select this object 
and click "Next". Note that it’s in case like 
this that it’s important to rename our 
objects. 

At the first step, the dialog box asks us if we want to concatenate or to add: 

 

 
 

Step 3: concatenate or add? 

Concatenate means: "add a data without 
separation". Add means: "add another data 
but as it must be done on a magnetic strip, 
e.g. with the ISO separator character 
between them". 

 

So, click on "Add another text or value" and click "Next", to continue at the first step: what 
kind of information, then the information itself, etc. 

If we forget what are the data already inserted, a text-boxe appear then at the bottom, showing 
the formula, we are building and a preview of its contents: 
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Encoding preview 

Once all the data inserted, select "Terminate" at the third step, instead of "Concatenate" or 
"Add" and click the "Next" button. Now, click "OK", and your encoding is ready. 

 

 

Connection to a database 
 

With the Professional and Expert editions of the software (and with the demonstration mode), 
your card template can be linked to any database using either an OLEDB or an ODBC driver. 
This gives access to the whole possibilities of storing and managing large amount of data. 

The Standard edition of eMedia CS2 can only connect to a Microsoft Excel™ datasheet. This 
solution is limited as these datasheets don't offer all the features of a database, but this allows 
us to manage a simple set of data.  

In most of the case, a dataseet will be enough for simple usage. 

 

Defining the database connection 
In the "Tools" menu, select the "Connect to database" option and a new window will all the 
database possibility will appear: 

 
Database connection – driver selection 

 
 

With the Professional and Expert editions and with the demonstration mode enabled, all the 
choices are enabled. With the Standard edition of the software, only the "Microsoft Excel 
worksheet" choice is enabled. 

Please notice that if you're using a two-sided template, the magnetic strip is now visible 
on the back side to avoid the designer to create objects at this place. 
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Now, either we already have a database and want to connect to it, either we don't have any 
database and want to create one. 

• If we already have a database, click on the radio button that correspond to the database 
type and click "Next". The following pages will help us to select your database and to 
configure the way to connect to it. 

• If we don't have any database, or if we want to create 
one, click on the "Create database" button. The wizard 
will help us to define the fields: names, types and 
lengths. The created database will be saved using the 
Microsoft Access™ format and the current card 
template will be automatically connected to this 
database. 

To add, modify or delete fields, just click on them in 
the grid with the right mouse button and select the 
corresponding command in the popup menu. 

Once the structure of the database defined, according to your needs, the wizard will ask 
we for a filename in which the database will be created. 

 

 
 

 

 

We'll now connect to the sample database provided. In the dialog box in which the type 
of the database is requested, click on "Microsoft Jet engine (MS-Access 2000)" and click 
on "Next". 

The wizard asks for the name of the database file. Click on the "…" button and select the 
"Company.mdb" database located in the samples folder, in: \Sample Cards\Price 
Tag\Files\Database.mdb  

  

The online help can be accessed from each drop-down menu, topic or "object 
properties" dialog box by pressing the F1 keyboard key. In "Table of contents" page 
click on "Database connection/Create database 
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Click on "Open" to select this database, then on "Next": 

Database connection – user ID and password 

 

 

In this step, we'll enter (if needed) the user ID 
and the password to provide to the DBMS if the 
connection needs an authentication. It's not 
the case for our example. 

 

 

 

Click on "Next" to display the next step. The list of table or views appears. Select yours. Or, a 
text-box waits for your SQL statement, enter yours:  

 
Database connection – Table or view selection 

 

Table: one of the tables of the database, and all 
the records stored in it. 

View: a set of records from one or many tables. 
It's called a "Request" in Microsoft Access™ or a 
"Stored procedure" in Microsoft SQL Server™ or 
Oracle™. 

SQL Statement: We'll be able to enter a SQL 
SELECT command in a text-box. For more 
information, please refer to the online help or your 
SQL documentation. 

With the "Cursor type" combo-box, we'll be able to choose between a Keyset cursor and a 
Dynamic cursor. 

 

The next step allows us to define if the user in operating mode 
will have the possibility to modify records, add new ones or 
delete existing records. 

 

You’ll also have the possibility to select a “Pictures folder”. 

This will be usefull when you know in which folder is stored 
the ID picture you’ll link to your tempaltes. 

You can also leave this option blank but your database will 
require to have the full path to the photo linked. 
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The next steps are very similar: a list of 
fields is shown, and each can be selected 
or not: 

 

 

 

 
Database connection – Fields selection 

 

• Display - In the first list, we select the fields which will be displayed to the user in 
operating mode (so we are able to hide certain fields). 

• Edit - In the second list, we select the fields that the user will be able to modify, if the 
authorizations were set in the previous step (so we are able to lock certain fields). 

Warning 

An "index" field (in this case ID Field) contains a number, automatically, defined by the 
database management system each time a record is created. Each record of the database will 
have its own number, which can be used as a unique identifier. An indexed field must not be 
able to be modified by the user, since it has been automatically defined; its parameters will 
therefore be set as not "to be edited" at the stage when the fields that can be displayed to the 
user are selected and not those he will be able to modify. 

 

Click on "Next" to gain access to the last step, in which we may review the selected records.  

 

 

 

 

 

 

 

This window will be displayable at any time by pressing the F3 function key. If the "1000" box 
at the bottom is checked, only the first 1000 records are shown (this is useful for remote DBMS 
to avoid latency). 
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Defining the link between the objects and the fields 
When we defined the connection to the database, we have only selected the database fields so 
that they are available as a source of object 

We'll now do the same with the Image, Text and Barcode objects. 

With the Image object: 
 

 

DB field as a path to a file   Before 
establishing the connection, verify that a 
specific field for recording photos exists (text 
type field) in the database. This field will be 
necessary to add the photo file access path 
each time we register an individual. 

 

DB Field: The Image object will connect to 
corresponding field in the table of the 
database. 

 

In automatic mode:  the files are named 
using a prefix and an index in the eMedia 
CS2 picture folder. (Can be change inside 
Tools / Options menu)  

 In manual mode: the "File save" common 
dialog box will be displayed, allowing the 
user to give a name to the picture 

From a Formula: the file will be saved in a 
file whose name is built from the results of a 
calculation. 
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Example: the picture name will result, of creation of a 
picture file named with the two informations from the 
database, and an extension that depends on the type of the 
file. If we set the "formula" as 
DBField("FIRST_NAME")&DBField("LAST_NAME") your file 
will be saved as: MaxMATHESON.jpg for exemple 

 

 

 

 

 

 

 

With the text, barcode and QR-Code objects: 
 

To do so, we just have to change the value of the "Source" property, by setting it to 
one of these three possible values: 

• Database field: the text or barcode object will contain the value of one of the 
fields of the database for the current record. The name of the corresponding 
field will be set in the "Data" property. 

• Database choice: the text or barcode object will contain the value of one of 
the fields of the database for the current record, and this value will be one of 
those defined in a second table. We'll see how to configure this later in this 
chapter. 

• Formula: A Formula or Expression in a programming language is a combination 
of values, of variables, of operators and of functions which, interpreted 
(assessed), calculated, produce (in return) another value. 

 

 

 

 

 

 

 

 

 

 

 

 

The "Formula editor" assistant helps in the programming of advanced formulas, enabling a large 
number of operations to automatically take place on all the objects that make up the card.  
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Database field: 

 

 

 

Select now the LastName object on our card template, 
which will contain the last name of the holder. Modify 
the "Source" property and set it to "Database field". The 
"Data" property is now a combo-box. Open it and select 
the "Last Name" database field. 

Do the same for the barcode / QR-Code if you have one, 
to be linked with the corresponding field. 

 
 
 
 

 

Formulas and database fields 
 

To enhance the overall performances of the application and the template, we may 
combine the formulas with the database fields. 
Suppose, for instance, that the FullName card object has been designed to hold the 
full name of the holder. 
But the first and last names of the holders are in two different fields of the database… 
 

In the sample “Business Card” included inside eMedia, as example:  
 
 

 
 
 
 
 
 
 
 
 
Source:  
Formula 
 
Data: 
Trim(Trim(DBField("TITLE")&""&DBField("FIRST_NAME"))&""&Case(DBField("LAST_NAME"))) 

 
The function “Trim” gets rid of additional space if they exist at the beginning or the end of each 
database field for cleaner results. 
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At the end in operating mode, 3 differents database field will be included in one single object 
to be displayed on the card. 

 
 
 
 
 
 
 
 
 
 
 
 
 The uses of formulas are mainly to gain times and efficiency. 
  

eMedia CS2 helps us to gain access to our own database, but also helps us to manage our 
data to print them out on the cards in the most coherent way. 
 
Often, databases contain more information that the one we need to print. 
 
You can link or not objects to the cards, but keep the display in operating mode to be filled 
upon creating new records. 
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Let’s go further with the "Database choice" 
By setting the "Source" property of a text or barcode object to the "Database choice" value, 
we'll help the user in operating mode to enter a value in the field, by selecting the correct one 
into a list of possible values. 
 
 
 
 
For instance… open the sample card template "Luggage card.eccs" in DEMO mode 
By default in C:\Users\Public\Documents\eMedia CS\Sample Cards\Luggages 
 
This luggage card can have different logo and color without having to rewrite the information 
for each record in the database. Moreover, a color must make it possible to distinguish each 
department of the company. 

Let's define this solution… 

For the "Database choice" source, we need another table in the database, containing all the 
possible values. So, in our database, we have two more tables, named "Type" and “Color”, 
containing the following records: 

 

 

 

 

 

 

Also, we have modified our main table, for that it contains the department in which the 
employee works. 

We have now to define an object on the card template, having its "Source" property set to 
"Database choice". 

The function (DB Choice source) is only programmable and active in the 
Professional and Expert eMedia CS2 editions or in DEMONSTRATION mode 



- 36 - eMedia CS2 – Quick Start Guide 

 
 

© 1999 - 2017 Mediasoft Development All rights reserved 
 228, rue de la Convention – 75015 Paris – France 

3 

 
When we click on the 
button on the right of 
object property "Source" 
to define, what this object 
will contain in operating 
mode, where the data will 
be extracted from, and 
what kind of data will be 
stored, the following 
dialog box appears. 
 

 

 

 

 

 

 

 
Settings of the object with "Database choice" source 

With these settings, in operating mode, when we create or modify a record, the input window 
will contain a combo-box filled in with all the possible values of the “Type” field of the “Type” 
database table. 

When the user will select one of these values and 
will save the record, the selected information will 
also be saved in the “Transport” field of the main 
table, and the value will correspond to the choice 
selected. 

 
 

 
 
 
 
 

When the record will be saved, the Transport field for Clémence Dupond will contain the value 
corresponding to "Transport": 2.  
 
Why 2? In the “Type” table, for the record, the “Type” field contains…2 which is “Bus”. 

Let's put the finishing touches 
Of course, we saved our template from times to times. And, if our template must be used by 
many users, we saved it on a network resource. 

But now, if we want to lock the template so the users will not be able to modify it, how may 
we do that? 
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Of course, we may change the access of the hard disk file, but this will not prevent the card 
from being modified by a user… 

So, we can lock out the card template from eMedia CS2 by assigning to it a password. To do 
so, open the "Edit" menu of the software and select the "Set password" command. The following 
dialog box appears: 

 
Passwords definition dialog box 

We may define two passwords, and for each, we must enter the password two times (to avoid 
keyboard errors). 

• The first password locks the access to the design mode for this template. The user will 
have to enter the password to be able to edit it design mode. But, the user will not have 
to enter any password to print out cards from the operating mode. So, only designers 
will have the ability to modify the contents of a card template. 

• The second password locks completely the card. The user will have to enter the password 
to open it, from any source. The card is restricted only to the people that know this 
password. 
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3.  THE OPERATING MODE 

The operating mode is intended to be used for printing cards out and/or to encode cards 
(magnetic strips, smart card and contactless smart cards) from one of the templates already 
created in design mode. 

The operating mode doesn't need any skill (just how to use a mouse and a keyboard). In this 
mode, the user will only have to enter data from the keyboard (for instance the name, the 
company, etc of the holder) click on buttons, and print the card out. 

eMedia CS2 will always launch in operating mode 
eMedia CS2 may be launched from the "Start" menu, "All programs" command. Or by double 
clicking on a template *.eccs file. 

The main window of the software in operating mode looks like this one: 

 

 

 

  

This window mainly holds the following elements: 

• The Menus bar, which gives access to the software functionalities. 

• The Tool bar, which gives access to the main functions. 

• The card preview, in which we may see at any time the card as it will be printed. 

• The input window, which allows us to enter information relative to the current card 
and/or relative to the current record of the database. 

• The tool bar of the input window, which helps us to move between records, to create, 
modify or delete the current record, to search record(s), etc. 

Menus bar Tools bar 

Card preview 

Tool bar of the input window 

Input window 
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Opening a card template 
To print a card out, we must before open a template that contains the graphical design of the 
card and the encoding information. 

To do so, select the "Open" command in the "File" menu, or in the tool bar, click on the "Open 
template" button. A "file open" dialog box appears. In this one, select the card template file we 
want the software to load in memory and click on the "Open" button.  

This card template may be locked out with 
a password. In this case, the dialog box on 
the right appears. Enter the correct 
password in the yellow text-box (this 
password was delivered to you by the card 
designer or the administrator) and click OK. 
If you don't know the password, click on 
"Cancel", accept the error message and try 
to open another card template. 

Once the template opened, we needs to 
enter the needed information in the input 
window and to print the card out. 

The input window 
In this window, we'll enter the data to be printed on the card. We'll also enter database 
information if the card template is linked to a database. In this case, the tool bar of the window 
will help us. The tool bar contains buttons only enabled if the card is linked to a database: 

 
Refresh the records 
This button tells the database server to resend all the data. 

 

Refresh the current record 
This button tells the database server to resend the current record. 

 
Display the records in a grid 
This button opens a window containing a grid with all the database records. 

 
Display the first record 
This button moves to the first record. The input window and the card are updated. 

 
Display the previous record 
This button moves to the previous record. The input window and the card are updated. 

 
Display the next record 
This button moves to the next record. The input window and the card are updated. 

 

Display the last record 
This button moves to the last record. The input window and the card are updated. 

 
Search one or many records 
This button opens a dialog box allowing us to search for records then print them. 

 
Create a new record 
This button empties all the text-boxes and prepares the display for a new record. 
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Modify the current record 
This button allows us to change the data of the currently displayed record. 

 
Delete the current record 
This button deletes the current record (a confirmation is requested). 

 
Launches the print of active card 

 
Resets all entered values on the card displayed 

These two last buttons are also present on the tools bar. 

 

Under the tool bar, the data are in fields defined as a label and an input box. This one may look 
like the following: 

  
A grayed-out box can't be modified. 

 Light gray may be modified. Click on it to place 
the cursor, or use the TAB key to move from 
boxes to boxes. 

  
Some boxes may have a button on the right. 
Clicking on it makes a list to appear. This list 
contains the allowed choices for the box. 

Select in the list the choice we want, and then 
click on it. The list disappears and the selection 
made is now in the box. 

 

This kind of combo-box allows faster and easier inputs than having to use the keyboard. 

 
 
 

Image acquisition 
 

To acquire a picture, just click on the button with a camera on it. The user interface of the manufacturer 
of your camera or webcam appears on the screen (if your device has been correctly installed). Acquire 
your picture. Once performed, the window closes and the picture is transferred in the image or photo 
object in the card. 
If, when you click on the button with a camera in eMedia, the user interface that appears is not the 
one that corresponds to the device you want to use, cancel the acquisition, and select "Select source" 
in the combo-box. The dialog box that appears then helps you to select the correct device. 
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The list contains choices for managing 
the picture: selection of an acquisition 
device, loading a new picture from disk, 
access to a dialog box for changing the 
zoom level and the rotation angle, 
calling an external program for image 
modification. 
 

 

Using a database 
 

When the data of your card are stored in a database, the buttons of the tool bar of the input 
window are enabled.  

 
Two of them have special meanings that require an explanation. These buttons are 
the "Display records" button and the "Find record" button. 

  
The data grid 

 
Click on the third button of the tool bar of the input window ("Display records"). A new window 
appears, in which the contents of the database is displayed. This window can be used for two 
purposes: it allows us to review the whole database contents (use the scroll bars on the right 
and below the grid), and it also allows us to display the card that corresponds to a record: just 
double-click on the corresponding record.  

 
 

If we want to display more then 1000 records, then slide the button upper right of the dialog 
box.  

At last this window allow you to select records if you want to print multiple one manually. Just 
hit the Print icon at the end in the “Database Records” window. 

Sometimes, the window may be desynchronized from the database (because other user that 
may have changed some record contents). New records may be invisible, for instance. We may 
then click on the "Refresh" button to resolve the issue. 
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Finding records 
For searching records, a window appears when we click on the corresponding button of the tool 
bar of the input window (the one with the magnifying glass). This window allows the search of 
records using four different methods: search of a value, utilization of a SQL filter, search of a 
range of values, search by record number. 

This windows also allows us to perform batch printing, e.g. to print out in a single pass all the 
records selected by the search 
options. 

Search of a value 

This is the default mode. When we 
click on the tool bar button, the 
window on the right appears. 

Just select in the combo-box the 
name of the field on which to 
search, and below the value to 
search for. 

Once these two informations 
entered, use the four arrow buttons 
on the bottom left of the window to 
display in the eMedia main window the first, previous, next and last record respectively. If no 
record can be found, or if no more records can be found, a beep will be heard. 

Search with a SQL filter 

Click on the "Advanced" button at 
the top of the window to be able to 
search from a SQL filter. The 
window looks like: 

This search mode requires some 
skills in SQL language to be able to 
enter a filter without syntax errors. 

Enter in the text-box in the middle 
of the window the filter clause of a 
SQL statement (i.e. the WHERE 
clause of a SELECT command). 
Then, as described previously, use 
the four arrow buttons to review 
first, previous, next and last record that correspond to this filter. 

 

 

Search in a value range 

The search mode is very useful 
when we don't know the exact value 
to search, as we are here able to 
ask the software to find all the 
values between a mini and a maxi. 

Click on the "Field range" button to 
display the following: 

Select the database field in the 
combo-box and enter in the two 
text-boxes the range of values 
(mini and maxi values) to search for 
in the field. All records having in this field a value between the two ones entered will be selected. 
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Use the four arrow buttons at the bottom of the window to display in the eMedia CS2 main 
window the first, previous, next and last records. 

Search by record numbers 

This search mode may only be used 
with DBMS that supports book 
marking, and for which numbers 
may be assigned to records. It 
allows us to select many records 
between two of them, so we are 
able, for instance, to request the 
first ten records (from #1 to #10). 

Click on the "Record range" button 
to show the following: 

Enter then in the two text-boxes 
the numbers of the first record to 
display and of the last record to display. 

As before, use the buttons at the bottom left of the window to display in the main window of 
eMedia CS2 the first, previous, next and last record of the selection. 

Batch printing 
Batch printing means: printing a set of records based on a common template (similar graphics 
and electric personalization) and on common data (having similarities). 

To perform a batch printing, we must first select the records that will be printed out. For this 
purpose, as explained in the previous paragraph, we’ll search for records. We may use any of 
the search features described above: search of a value, with a SQL filter, in a value range, by 
record numbers. 

Once the records we want to print selected, just click on the button holding a printer icon at 
the bottom right of the dialog box, and the cards will be printed, one for each record. 

Don’t forget to feed the printer with enough blank cards, or feed your printer from times to 
times. 

Remember: it’s not a good idea to print large amount of cards in a single operation. If eMedia 
CS2 can handle large amount of copies, you have to keep in mind your other limitations: 
Windows spooler, memory, and also printer has its own limits: the capacity of the card charger, 
or the ribbon which has an end and the printing head that must be cleaned once a certain 
amount of copies is reached. 

During a batch printing, in case of emergency, we may, at any time, click the “Abort” button of the 
print dialog box to stop immediately any printing operation from the software. Don’t forget in this 
case to also cancel the print jobs in the printer queue as the one already sent won’t be deleted. 

Printing the card out 
Once the data entered and displayed on screen, we can print the resulting card out. We may 
perform this operation in four ways: 

• The "Print" button at the bottom of the input window, 

• The "Print" button in the tool bar on the top, 

• The keyboard shortcut Ctrl+P, 

• The "Print" command of the "File" menu. 

Notice that the "File" menu allows supplemental operations, or partial operations. The other 
ways to print can be considered as the "Print all" command. 

From the "File" menu, we'll be able, for instance, to print out only the front side, or the back 
side, or to perform only the encodings. 
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The "File" menu will also allow we to: 

• Configure the default printer, from the "Print setup" command. eMedia CS2 doesn't use 
the default printer of the workstation, but uses its own default printer (because the card 
printer is not often the default printer!) 

• Preview the data that will be printed and encoded on the card (for instance to preview 
the data that will be stored in the magnetic strip). 

• Specify a number of times a card will be printed: if we can enter a number of copies from 
the printer preferences dialog box, these copies will be strictly identical, including the 
value of the print counter and even the value of the Mifare serial number! To avoid this, 
we may use the "Print count" command. With this one, the print counter will change 
between each card and the Mifare serial number will be read on each card. Be aware that 
specifying a number n of copies from the device preferences and p copies from this menu 
command, we'll obtain n x p cards. 

We may also control the printout of the front and the back side of the card from data located 
on the card and from data in the database. But, as this is advanced features not covered by 
the current document, please refer to the online help. 

 

 

From our internet web site, you can contact us for your questions, feedback or suggestion to 
improve this guide.  

 

Your contacts are ready to help you: 

internet web site:  http://www.eMedia CS.com 

email:  support@eMedia CS.com  

 

https://www.emedia-cs.com
mailto:support@emedia-cs.com
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